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 Warning!
It is  essential that you read and understand this  entire manual, the Product Manual(s) for all devices 
connected with Modbus  or drive.web and the entire contents  of the savvy software “Help” menu 
before proceeding with your installation and product configuration. For more information and copies  of 
product manuals and software, go to www.driveweb.com.

 Warning!
Your use of savvy software, drive.web devices with Modbus may cause motors  and machinery to 
power up with high voltages or start or operate in an unexpected, dangerous or lethal way. It is  essential 
that you are completely familiar with savvy and all of the equipment and the system design you are 
working with before attempting to program or edit a program or connect to any live device.

 Warning!
You are entirely responsible for the configuration or use of any drive.web product. By configuring or 
using these products you agree to indemnify and hold harmless  Bardac Corporation, its’ employees, 
directors, officers, distributors  and resellers  against the consequences  of your configuration or use of the 
products.

drive.web  Introduction
Rugged, versatile, and easy to use process  and drives  management system. Interface, add 
functionality and internet connectivity to any ModbusRTU enabled devices:

Generic Modbus RTU Master, dw117 and dw121.
Invertek Optidrive Plus and VTC with dw118 and dw121.
Yaskawa YF7 with dw119 and Yaskawa V1000 with dw120.

Create large integrated systems. Processing bandwidth is not affected by system size. 

speedy485  Features
drive.web distributed process control over Ethernet

Modbus TCP/IP Slave Ethernet enabled slave/server included.

Internet accessible configuration, monitoring & control. 

“Drag ‘n drop” easy connections with graphical documentation.

Automated, on-line upgrades with savvy software.

Optional Function Block Libraries Process, Winder and Math.

Function Blocks; Complete drive control and monitoring with 
dw118-120, Math, logic, PID, comparator, filter, latch, timer, counter, 
ramps, winder diameter, taper tension, torque compensator, more.
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speedy485 Base Models
All speedy485 models  include drive.web over Ethernet distributed 

process  control, Basic Control Function Block Library with 
arithmetic, logic, PI, clamps, data switches  and more. See page 8  
Also, Modbus TCP/IP Slave.   See page 6.

dw117 speedy485 controller with ModbusRTU Master or Client, 
EIA485 via standard terminal block, up to 115kbps.

dw118 speedy485-o Control your Invertek Optidrive Plus with 
dedicated serial link and extensive parameter control and monitoring.

dw119 speedy485-yf7 Control your Yaskawa F7 Drive with 
dedicated EIA485 serial link via a standard terminal block. Extensive 
drive parameter control and monitoring.

dw120 speedy485-v1000 Under Development, Please Call.
dw121 speedy485-6p6c controller with ModbusRTU Master or 

Client, EIA485 via 6P6C RJ jack, up to 115kbps.

speedy485 Available Options
See Appendix A for a complete listing of  function blocks by library and option.
05 Process Control. Function Block Library 1 - Math, Logic, PID, 

Switches, Comparators, User log, Latch, Filters and more.
06 Winder Control Function Block Library 2 - Diameter Calculator, Taper 

Tension, Torque Compensator.
10 Advanced Math Function Block Library 3 - Trig, Polynomials, Roots, 

Log, Exponent, more. 
Options Important Note, these software options are easily field installed, 

follow the upgrade guide under the Commerce menu in savvy.

speedy485 Winder Specials 
Include options 05 and 06 and pre-installed winder system configuration 
1101 speedy485 winder 1  Open Loop Constant Tension Center Winder. 
1102 speedy485 winder 2 Closed Loop Dancer Control Center Winder. 
1103 speedy485 winder 3 Closed Loop Loadcell Control Center Winder.

speedy485 Installation
Warning!   Dangerous, High Voltages that may cause injury or death are 
present on drives, motor controllers and other industrial devices! 
Only qualified personnel who are completely familiar with the device that the 
speedy485 will connect to should proceed!

Dimensions and Weight: 4.25”(dw117,119 4.7”) x 1.8” x 1.15” (107(119) x 46 x 30 mm). 3.4oz(97g).
Power Requirement: 24VDC ±15%, ~50mA, ~1.2W. 
Storage and Operation Environment: Clean air, Temperature range; 0 to 50C. 

Humidity less than 95% non-condensing.
Ethernet Port Standard RJ45 8P8C, 10BaseT, Link and Activity LED’s
Mounting: Adhere the speedy485’s  self-adhesive hook and loop strip on or near the 

drive or EIA485 device.  Be careful not to obstruct any air vent holes  or access  points 
and do not obscure any product labels.  Do not attach the speedy485 near any hot 
spots such as heatsinks, cooling fans, etc., nor near to drive power terminals.
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speedy485 Installation continued...
Wiring Notes All signal wiring should be twisted-pair. All wiring outside of the metal 

enclosure should be shielded cable with individually shielded twisted-pairs  such as 
Belden 8163.  Ground the shield at only one end, usually near the signal destination.  
Ground the shield with a 360° clamp where the shield enters  your metal enclosure. Route 
all wiring away from RF noise sources and AC power cabling. 

	 Data  	 EIA485 Name		 Description
 A A or “Data -”  Inverting Pin
 B B or  “Data +”  Non-Inverting Pin
	 C	 Data 0V	 	 EIA485 Reference Common

A and B must share a single twisted pair. C may use one or both conductors  in another 
pair. Do NOT pair C with any other signal.
Industrial wiring practices  usually recommend cable shields land at only one end to 
prevent ground loops so C connection may not be properly made with the shield.

Long cable runs can mean large potential ground differences. Connect a 100 Ohm 
isolation resistor in series  between C and a Data 0V or Reference Common terminal on 
your networked device. Note. drive.web devices  with option 02, 12, 18, 19 or 23 
include this resistor and a dedicated C terminal.
If  you require a network over 150 meters long, contact us for technical manual HG502436.

dw118 Set up Your Optidrive Plus
Check your model number and firmware revision. P0-28 and P0-29 should 
indicate 2.2 or higher. Model number must end in -M for firmware revisions less than 3.0.
Check that baud rate and drive communication address are at default settings.  
P2-26 must be 115.2 kbps and P2-27 must be 1.  
If your ODP is  part of an Optibus network, use the Data Cable Splitter, OD485SP-IS 
to allow communication with your speedy485. The speedy485 will only 
communicate with the master.

dw119 Set up Your Yaskawa yf7
Check parameter U1-14, Flash ID = 3020. This is currently the only supported software.

You will need to connect the terminals, S- and R-, together for EIA485- or A.  S+ and R
+ connected together make the EIA485+ or B connection. 
Set the baud rate at parameter H5-02 to 4 for 19.2 kbps.
Check the Modbus Unit address, Parity and Delay times are at default settings:  

H5-01 = 1F = Address, decimal 31
H5-03 = 00  No Parity
H5-06 = 05  Minimum delay, 5ms 

Set H5-04, Stopping Method and H5-05, Serial Fault Detect to set drive response to serial coms loss.
Important Note:  You must cycle the YF7’s  power, waiting for the screen to blank before 
repowering, in order for the changes to take effect.
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dw118, dw121 with 
6P6C Connector

1.  B, EIA485 +
2.  0V
3.  +24VDC
4.  NC
5.  NC
6.  A, EIA485 -

dw117, dw119 and dw120 with 
Pluggable Terminal Block

0V    24V

C
A
B

Optional 
100Ω 1

2
3
4



speedy485 Ethernet and savvy
It is important to have a basic understanding of Ethernet TCP/IP networks. 
Assigning an invalid or duplicate IP address will cause serious network malfunctions! 
speedy485s  are all shipped with the IP address, 10.189.189.189. Consult your 
company’s IT department for an appropriate, unique IP address.

Find useful networking information in the Basic Network Administration in 
the savvy user manual under the Help menu. 

Set up Your Physical Ethernet Network - You Will Need:
A standard Category 5e cable (with 8P8C/RJ-45 connectors  on both ends) for 
each drive.web  device and your computer.
For systems  with more than one drive.web. device, an Ethernet switch with 
sufficient ports to support all your drive.web devices and your computer.

Set up Your Computer - Get savvy
With free drive.web savvy software, easily program and monitor your 
speedy485, perform data trending and create distributed control systems.

Download the latest version of savvy and view the savvy user manual. Go to 
driveweb.com, click on Get savvy or get savvy on the Bardac Infodisk.
Windows users  will need to have Java Runtime Environment installed to 
run savvy. There is a link on the  Get savvy page to download Java for free.  

Get started with savvy
Before proceeding with your systems designs it is  very important to familiarize 
yourself  with savvy, the configuration software. 
We strongly recommend that you read the introductory guides  under the Help 
menu; Getting Started with savvy, Getting Started with savvy-SFD, and 
savvy-SFD and the PL series drive.
Use Create Phantom in the Directory menu to practice, explore all drive.web 
products and options and design and configure off-line. Design systems in 
Phantom devices  and Export Data under the Directory menu for later use in 
live devices. Import Data into  phantoms to work off-line. 
We strongly recommend you attend our free on-line training seminars. Call us  or 
email training@driveweb.com to register.
Under Directory menu, click Discover All Local Devices. If your speedy485 
is powered up on the same local network as your computer, an icon should appear.  
Discover drive.web devices  anywhere on the internet unless  they are protected 
by firewalls  or other network security devices. Assign a public IP address  or use a 
VPN. Under the Directory menu, click on Discover Device...  
If the icon at right appears  with the red padlock and comms-fail indication, a 
network connection problem exists. Check connections, LEDs  and that the 
speedy485  IP address is within your computer’s subnet mask.  
Warning! Changing a device IP address  WILL disrupt its  network connections! 
If a smarty is  communicating with other devices or drives you must be prepared 
for system disruption and to remap connections  in those devices  when changing 
an IP address. In the File menu choose Utility > Remap Export File to remap 
a dw-system file with different IP address(es).
Under the File menu, click Administrate > Set IP Addresses for System.  
Locate the serial number on the product label of your speedy485. Enter a 
unique IP address  that is  within your computer’s  subnet mask and click OK.  A  
device icon should appear with IP address beneath.  
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Get started with savvy continued...

Right-click on the device icon and choose Export Device Data to save the 
configuration as a dw-system file. Alternatively, Export Data under the Directory 
menu saves  all devices’ configurations  and connections in one file. Note! Import 
(Device) Data overwrites the configuration(s) with data in the dw-system file. 

savvy views  are hierarchical from Directory view at top to Function Block view at 
lower level. Use the navigation arrows  in the top margin to view the next higher level 
or go backward and forward through views. Note that menus change as you navigate. 

savvy function may be limited if you do not have the required password capability 
level, a device is locked with a password, a parameter has  an incoming connection or 
a crossed-out pen is shown, indicating read-only.

Hover cursor over devices, function blocks, connections  and parameters  to see topical 
information in the top margin.

Click any blue connection to jump views to the other end.

Right-click on the device icon in any view for its  Contextual Menu. Choose Change 
Name to name your device for easy identification. A powerful Find Parameter... 
function locates and jumps views. Simply enter a number, name or partial name. 

If serial connection with your drive is  lost, its’ icon will include a yellow warning 
triangle adornment and, if  no serial connection has been made, a question mark.

Click the device icon to view the Device Overview screen (Standard savvy, no 
SFD). Click on native drive functions, Function Block Engine or Modbus to view. 

In the Function Block Engine view (Standard savvy, no SFD), click the FBE menu 
and select function blocks  in the order that you want them to be processed. Processing 
order is from left to right, then top to bottom.

Click on a function block to view its parameters and functional detail. 

Right-click on a parameter for its  Contextual Menu. Get Info, Add to Dock, Copy, 
Connect to… start or end connections, Re-name..., and Re-scale...

Effortlessly connect between parameters  and to parameters in other drive.web 
devices over Ethernet. 

Under the File menu, choose New Viewer... and then Open Device Directory. 
Now you can click on a parameter, drag a connection and drop onto a destination 
parameter in the other viewer.   

Click on parameters  to open the Setter Box. Adjust the value with convenient 
graphical buttons or keyboard entry.

Most drive.web parameters  use 16 bit words allowing raw decimal integer values  0 
to 65535 or ±32767. These raw values  are formatted, limited and scaled depending 
on the parameter.  Use Get Info or Re-Scale to verify or change.

A blank rectangle connected to or from a parameter indicates  a remote device is not 
discovered in savvy. 

Right-click on any drive.web-over-Ethernet or drive.web-to-drive connection to 
Change Sample Period… Shorter periods mean faster response and higher loading.

High loading by complex function block configurations, numerous, fast Ethernet, 
Modbus  and/or drive connections may produce Timebase Overrun indications at 
the System function block. Performance WILL be affected. Right click on the 
System block to adjust the Timebase Setpoint. Make a connection from Program 
Status parameter to log these occurrences, provide contingencies or warning signals.
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A1 speedy485

Upgrade savvy with Signal Flow Diagram Option - SFD
With savvy-SFD, build systems  graphically while creating 
live drawings that are stored in your speedy485.  
Set borders, drag and drop connections, zoom, pan, cross-
reference and annotate multi-page drawings. 
A separate function block and connection listing shows 
program execution order from top down. Change execution 
order by dragging function blocks up or down. 
Select Upgrade savvy under the Commerce menu. 
Process  a Voucher or credit card on-line any time. Contact 
us  with the savvy ID shown in the About drive.web savvy 
window for an off-line upgrade Coupon.

speedy485 ModbusTCP/IP Server
Conformance Class 0, Function Codes 03 &16. 
Supports up to three simultaneous masters.
View the Modbus Slave function block by clicking on the Modbus 
icon in your savvy system configuration.
ModbusTCP Slave Port 502 is  the standard specified in the 

protocol. You can change to match the Modbus master in the 
unusual case that it is non-standard.

Modbus Slave Indirect parameters  are sequentially numbered so all or groups  can be 
read or written with one command.  Enter any parameter number in your function 
block engine in these parameters. Create more Modbus Slave Indirect blocks  from 
the Utility function block list group.
You are not required to use the Modbus Slave Indirect blocks. Your ModbusRTU 
master can directly address any numbered parameter in your function block engine.
Right-click on parameters  and Get Info. You cannot write or force parameters that 
cannot have incoming drive.web connections  nor parameters  with incoming 
drive.web connections indicated by a blue arrow at left side of  the parameter block. 

dw117 and dw121 Generic ModbusRTU Master
Supports Modbus Function Codes 03, 06 &16.
EIA485 allows multi-drops. One master or client device can poll many slave or 
server devices  individually. Correct multi-drop topology is  daisy chain or one trunk 
with a device at each end and other devices  on individual short stubs. Star, ring, or 
extended branch topologies are NOT recommended.

drive.web control technology

speedy485 HG502271Iss2.1  www.driveweb.com                            Page 6/8

One Twisted Pair for A and B
One Twisted Pair or single 

conductor for C

Keep Drop Stubs 
as Short as Possible

Connect Shield 
at One Ground 

Example Multi-drop Network 
with Trunk and Stubs

Install a 100 Ohm resistor in 
series with 0V for C unless a 
dedicated C terminal is provided. 



speedy485 dw117 and dw121 ModbusRTU Master continued...
It is  possible to connect up to 128 EIA485 drive.web devices  on the same electrical 
network, but note that this number may be reduced by other network factors.

Comms Port Function Block
Configure your serial port with the ModbusRTU Comms Port function block.
Comms Speed. Communications  rate in bits  per second (b/s). Set between 300 

bps and 115.2 kbps. Must match the slave device's settings.
Comms Configuration. The character framing format is 8 Data bits-Parity-Stop bits. 

Supported character framing is: 
8-N-1 	 8 Data Bits, No Parity, 1 Stop Bit
8-O-1	 8 Data Bits, Odd Parity, 1 Stop Bit
8-E-1	 8 Data Bits, Even Parity, 1 Stop Bit 
8-N-2 	 8 Data Bits, No Parity, 2 Stop Bits

Actual Polling Period Read-only. Time in milliseconds, 
ms, required to poll all parameters  defined in all the 
Modbus  Holding Register blocks. The period is  directly 
affected by the number of registers, comms  errors, 
comms timeouts, and the comms sleep time. 

Comms Timeout. Time in milliseconds, ms, for the master or client to wait 
for a reply before moving to the next parameter in the polling cycle.
Range=0 to 30000 ms 

Comms Sleep Time. The time delay in milliseconds, ms, between the end 
of the previous  and the start of the next polling cycle. May be adjusted to 
limit microprocessor loading of the drive.web or slave device if serial 
link update performance is not a critical factor.

Status. Any of the Last Errors  of the individual Holding Register function 
blocks. All individual Last Error codes  can be cleared by clicking on the 
parameter and using the Reset button.

Enable. You may globally disable the serial 485 communications here. 
Holding Register INT16 or UINT16 Function Blocks
Define the data point and the slave or server device. Create 
multiple instances  of these blocks, one for each remote 
parameter. The Holding Register’s  Value parameter may 
have drive.web connections  to and/or from it, allowing 
read and/or writes to the remote parameter. 
Modbus Address is  the unique address  number between 1 

and 247 assigned to your slave or server device. 
Data Address is  the parameter identification number, PIN 

or register number in your server that you wish to read 
and/or write to/from. 

Enable allows this  register’s  comms to be disabled to reduce polling periods. 
Make a drive.web connection to this block for dynamic control.  

Last Error records  the last error communicating to this address. Click to 
reveal the Reset button.

Options: A check box for certain devices  that require function 06 instead of 
16. There is  another check box for Yaskawa drives’ special Yaskawa 
Accept/Enter function.

Value shows  the decimal integer which is  read/written to/from the slave’s/
server’s addressed register.
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Winder
 18 Diameter Calculator
  7 Taper Tension
 30 Torque Compensator

Option 06

Utility 
  4 Modbus Indirect 

Option 04

Arithmetic
  3 Differential Splitter
  4 Multiplier-Divider
  3 Sign And Value
  3 Sign Changer
Clamps
  5 Clamp with Monitor
  4 Deadband
  4 Skipband
Comparators
  4 Comparator
  5 Equality Comparator
  3 Maximum
  3 Minimum
  6 Window Comparator
Control
  6 Differentiator
  8 Integrator

 15 PI
 20 PID
  8 Profiler
Counters
 17 Up/Down Counter
Drive Helper
 11 Optidrive Helper
Filters
  4 Low Pass Filter
  5 Moving Average Filter
 Latches
  4 D Latch
  5 D Latch with Reset
  5 D Latch with Set
  6 D Latch w/Set, Reset
  3 SR Latch
  4 T Latch

Logic
 17 16-Bit Binary Encod.
 17 16-Bit Binarty Decod.
  5 4-Bit Binary Encoder
 16 4-Bit Priority Encod.
  3 Bitwise AND
  2 Bitwise NOT
  3 Bitwise OR
  3 Bitwise Shift
  3 Bitwise XOR
Logic Gates
  3 NAND
  3 NOR
  3 XNOR
  3 XOR
Ramps
  7 Linear Ramp
 11 MOP

 17 S Ramp
Switches
 18 16-In Switch
 18 16-Out Switch
  6 4-In Switch
  6 4-Out Switch
 10 8-In Switch
 10 8-Out Switch
  3 Track and Hold
Timers
  5 Delay-Off  Timer
  5 Delay-On Timer
  3 One Shot
  5 Oscillator
  8 Underlap
Utility
  4 User Logger

Process Control Library Option 05

ModbusRTU Master
  7 Comms Port
 48EurothermERCFW09
  6 Holding Reg. INT16
  6 Holding Reg. UINT16
 54 Optidrive Plus
 54 Optidrive VTC
 48 WEG CFW09

dw117, dw121
Math
  2 ArcCosine
  2 ArcSine
  2 ArcTangent
  2 Cosine
  2 Cube
  2 Cube Root
  2 Exponential

  2 Logarithm
  2 Reciprocal
  2 Sine
  2 Square
  2 Square Root
  2 Tangent

Option 10

Arithmetic
  3 Adder
  3 Divider
  3 Multiplier
  3 Subtracter
Clamps
  4 Clamp

Control
 15 PI
Drive Helper
 11 Optidrive Helper
Logic Gates
  3 AND
  2 NOT

  3 OR
Switches
  4 2-In Switch
  4 2-Out Switch
Utility
  1 Dev. Comms Monitor
  1 Indicator

  4 Parameter Block
  6 Watchdog
  1 Watchdog Driver

Basic speedy485

speedy485 Appendix A Function Blocks by Library and Option
Subject to change without notice.

Appendix B drive.web Product Line Overview
smarty distributed process controller simultaneously manages  varied process  components  and drives  with 

analog and digital I/O, up to two incremental encoders, dual serial ports, ModbusTCP/IP and RTU. 
speedy sp and speedy485 Processing power, tailored for your drive or generic, Ethernet, EIA485. 
savvy-SFD Signal Flow Diagram Option Easily implement your systems designs. “Drag n’ Drop” 

connections with graphical documentation created in one step and stored in your device. 
Free drive.web Training Courses-online training seminars  every week. They are interactive with the 

presenter and take about one hour. Learn essential elements:
Design control schemes, configure networks, create drive systems  with almost any drive, generate 
signal flow documentation, configure drives, interface to external products  such as  operator stations, 
PLCs, etc and work with your drives across the Internet. 

More extensive online and factory training available. Call or email training@driveweb.com to register.
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drive.web 40 Log Canoe Circle, Stevensville, MD 21666 USA. 
Ph. 410-604-3400, Fax 410-604-3500, www.driveweb.com
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